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Overview - FmPro Migrator Batch Transfer

This document explains the operation of the FmPro Migrator Batch Transfer utility and how to
configure a scheduled job on Windows or macQOS to run it at regular intervals.

The FmPro Migrator Batch Transfer app is designed to be scheduled to run atregular intervals in
order to transfer data from FileMaker to SQL databases in an automated manner.

Limitations:
(1) The batch transfer process is supported with regular data fields in FileMaker and does not
support transferring repeating fields data or container fields.

Manual Revision 3
FmPro Migrator Batch Transfer 1.05
7121/2021

[Revision Notes: Updated with support for new xferData.exe perl2EXE compiled executable, and
updated install notes and troubleshooting for MySQL and PostgreSQL database servers.

Added support for macOS 10.15 since xferData.app is how a 64-bit executable on macOS with
64-bit and 32-bit executables available for Windows.]
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Theory of Operation
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Usage with FmPro Migrator Platinum Edition
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FmPro Migrator Transfer Data

Migration Process
CFs GUI

”mnmaf

Original Table NewTable  Source |Destination [Fields |Records

Clients (1] cllents FileMaker 18

TOs

IELIESE  Relationships Value Lists Layouts  Scripts

Step 2 . Companies i FileMaker 18

Install the FileMaker . . =

ODBC driver Companies 2 i FileMaker 18
' Members FileMaker 18

Create an ODBC nlaceholder table nlaceholder table FileMaker 18

DSN matching the
DSN name listed in

th.e Table Details Original Fieldname PK |Auto-Increment [Next SN
window. AddressLine1

Turn on ODBC
Sharing within
FileMaker.

Menu: File > Sharing
> ODBC/JDBC

© steps
Click the Get -

FieldSize icon. [ “ 3

Troubleshooting:
Make sure the
specified ODBC DSN

Get Fieldsize Create Table

Completed

Transfer Data

Completed Not Started

Optional
|

Image
Transfer

The FmPro Migrator Batch Transfer utility uses the configuration and files created by FmPro
Migrator in order to set up its batch transfer configuration.

(1) When holding down the Shift key while (2) pressing the Transfer Data button - FmPro Migrator
creates and uses xferData.EXE/APP and xferData.pl files to transfer data from FileMaker to SQL
databases.
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NOTE: These xferData files only get written if the Shift key is pressed at the same time the Transfer
Data button is clicked.

macOS xferData Files

/\ PERL

xferData.app xferData.pl

FmPro Migrator generates the xferData.pl file and writes it to disk within the FmPro Migrator project
folder. It also writes the xferData.app executable into the same folder. The xferData.pl file is
custom generated to match the fields and table name selected in FmPro Migrator.

Then FmPro Migrator launches the xferData.app application. As soon as this application runs it
looks for the xferData.pl file in the same folder and runs it. After the data is transferred, the
xfer_completed.txt file is written to signify that the data transfer has completed without errors. If the
data transfer fails, then the xfer_failed.txt file is written containing the text of the error message.

Windows xferDataFiles

xferData.exe xferData.pl

FmPro Migrator generates the xferData.pl file and writes it to disk within the FmPro Migrator project
folder. It also writes the xferData.exe executable into the same folder. The xferData.pl file is
custom generated to match the fields and table name selected in FmPro Migrator.
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Then FmPro Migrator launches the xferData.exe application. As soon as this application runs it
looks for the xferData.pl file in the same folder and runs it. After the data is transferred, the
xfer_completed.txt file is written to signify that the data transfer has completed without errors. If the
data transfer fails, then the xfer_failed.txt file is written containing the text of the error message.

File Copying

companies
m )

a xferData.app

members xferData.pl
tbl_assets

tbl_maintenance_records
tbl_value_list_data_items

23
I
I
I
When adding a table to the list of tables to be processed, the FmPro Migrator Batch Transfer utility
makes a folder using the name of the database table and copies these files into the folder. When
the configuration has been completed, a folder have been created for each table which needs to
be transferred during batch transfer processing.

Truncate Tables

Note1: Each SQL database table will first be truncated by the FmPro Migrator Batch Transfer
utility, before transferring all of the data. This process prevents conflicts due to duplicated primary
key columns.

Note2: It also means that all records are transferred during each data transfer. This process
doesn't require making any changes to the original FileMaker database to add trigger
scripts/calculations to each table.
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Installation
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Windows Installation - FmPro Migrator Batch Transfer

Unzip Application

' FmProMigratorBatchTr

-l ONAL - A0 000 DAA =

Open

Open in new window

Extract All...

7-Zip >

CRC SHA >
Pl FolderSizes 8 >

Pin to Start

Open on Mac

Show in Finder

Share on >
¥ Install with Revo Uninstaller Pro
[ Scan with Windows Defender...
|2 Share

Open with >

& UltraEdit

pressed (zipp...

10,026 KB

The FmPro Migrator Batch Transfer utility is delivered as a zip file. Right click on the zip file, and
select Extract All... from the contextual menu to extract the contents.

Move Application Folder (Optional)

Name

You can move the application folder to the Program files folder or wherever else you find

Date modified

convenient. No installation application is required.
The first time the app runs, it will create a preferences folder named FmPro Migrator Batch Transfer
within the Documents directory. A preferences file named FmPro_Migrator_Batch_Transfer.json

will be created within this folder.

Type

File folder

Compressed (zipp...
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Note: The version number is notincluded in the name of the app, so that it can be updated without
requiring a change to the job scheduler configuration.
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Windows - DBD::mysql & Strawberry Perl Installation

In order to support the DBD::mysql module, it is necessary to install Strawberry Perl on Windows,
then use cpan to install the required modules.

Download & Install Strawberry Perl for Windows

The Perl for MS Windows, free of charge!

% L Perl is a programming language suitable for writing simple scripts as well as
: complex applications — see https://www.perl.org.

Strawberry Perl is a perl environment for MS Windows containing all you need
to run and develop perl applications. It is designed to be as close as possible to
perl environment on UNIX systems.

It includes perl binaries, compiler (gcc) + related tools, all the external
libraries (crypto, math, graphics,xmLl...), all the bundled database clients
and all you expect from Strawberry Perl.

Recommended version:

"When I'm on Windews, I use Strawberry Fer!" strawberry-perl-5.30.2.1-64bit.msi
. L,,,y whall strawberry-perl-5.30.2.1-32bit.msi

If you are using the 64-bit version of FmPro Migrator, then download the 64-bit version of
Strawberry Perl from: www.StrawberryPerl.com

A 32-bit version is also available.

Note: Before installing Strawberry Perl, remove any previous versions you may have installed like
ActiveState Perl. This can be done via the Programs & Features control panel in Windows. You
can also perform the following test atthe command line:

perl -v

To make sure that everything got removed from the previous version, before performing the new
installation.
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Install DBI Using cpan

E¥  Windows PowerShell X ¥ Windows PowerShell X + v = O >4

PS C:\> cpan @

Loading internal logger. Log::Loguperl recommended for better logging

Unable to get Terminal Size. The Win32 GetConsoleScreenBufferInfo call didn't work. The COLUMNS and LINES environment va
riables didn't work. at C:\Strawberry\perl\vendor\lib/Term/ReadLine/readline.pm line 410.

cpan shell -- CPAN exploration and modules installation (v2.27)
Enter 'h' for help.

cpan> install DBﬂ 2

Once Strawberry Perl has been installed, using the command prompt or PowerShell:
(1) cpan

Then install the DBI module.

(2) install DBI

All dependent modules will be installed and you will be returned to the cpan prompt.

Install DBD::mysql Using cpan

cpan> install DBD: :mysql

relcning witln LWV,
http://cpan.strawberryperl.com/authors/01lmailrc.txt.gz

Fetching with LWP:
http://cpan.strawberryperl.com/modules/02packages.details.txt.gz
Fetching with LWP:

http://cpan.strawberryperl.com/modules/03modlist.data.gz
Database was generated on Fri, 15 May 2020 04:00:07 GMT
Updating database file ... Done!
DBD: :mysql is up to date (4.050).

cpan>

Using the same cpan shell, install DBD::mysq|

Note: Capitalization does matter when entering the names of cpan modules.

FmPro Migrator Batch Transfer - Usage Manual - 15



Install DBD::ODBC Using cpan

cpan> install DBD: :0DBC
Database was generated on Tue, 26 May 2020 ©1:08:45 GMT

DBD: :0DBC 1s up to date (1.61).

Using the same cpan shell, install DBD::ODBC

Quit cpan shell

cpan> (
Lockfile removed.

PS C:\>

Type g and then return to quit the cpan shell.
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Windows - DBD::Pg & Strawberry Perl Installation

In order to support the DBD::Pg module, itis necessary to install Strawberry Perl on Windows, then
use cpan to install the required modules.

Download & Install Strawberry Perl for Windows

The Perl for MS Windows, free of charge!

% L Perl is a programming language suitable for writing simple scripts as well as
: complex applications — see https://www.perl.org.

Strawberry Perl is a perl environment for MS Windows containing all you need
to run and develop perl applications. It is designed to be as close as possible to
perl environment on UNIX systems.

It includes perl binaries, compiler (gcc) + related tools, all the external
libraries (crypto, math, graphics,xmLl...), all the bundled database clients
and all you expect from Strawberry Perl.

Recommended version:

"When I'm on Windews, I use Strawberry Fer!" strawberry-perl-5.30.2.1-64bit.msi
. L,,,y whall strawberry-perl-5.30.2.1-32bit.msi

If you are using the 64-bit version of FmPro Migrator, then download the 64-bit version of
Strawberry Perl from: www.StrawberryPerl.com

A 32-bit version is also available.

Note: Before installing Strawberry Perl, remove any previous versions you may have installed like
ActiveState Perl. This can be done via the Programs & Features control panel in Windows. You
can also perform the following test atthe command line:

perl -v

To make sure that everything got removed from the previous version, before performing the new
installation.
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Install DBI Using cpan

E¥  Windows PowerShell X ¥ Windows PowerShell X + v O >4

PS C:\> cpan @

Loading internal logger. Log::Loguperl recommended for better logging

Unable to get Terminal Size. The Win32 GetConsoleScreenBufferInfo call didn't work. The COLUMNS and LINES environment va
riables didn't work. at C:\Strawberry\perl\vendor\lib/Term/ReadLine/readline.pm line 410.

cpan shell -- CPAN exploration and modules installation (v2.27)
Enter 'h' for help.

cpan> install DBﬂ 2

Once Strawberry Perl has been installed, using the command prompt or PowerShell:
(1) cpan

Then install the DBl module.

(2) install DBI

All dependent modules will be installed and you will be returned to the cpan prompt.

Install DBD::Pg Using cpan

cpan> install DBD: :Pg
DBD::Pg 1s up to date (3.12.0).

cpan>

Using the same cpan shell, install DBD::Pg

Note: Capitalization does matter when entering the names of cpan modules.

FmPro Migrator Batch Transfer - Usage Manual - 18



Install DBD::ODBC Using cpan

cpan> install DBD: :0DBC
Database was generated on Tue, 26 May 2020 ©1:08:45 GMT

DBD: :0DBC 1s up to date (1.61).

Using the same cpan shell, install DBD::ODBC

Quit cpan shell

cpan> (
Lockfile removed.

PS C:\>

Type g and then return to quit the cpan shell.
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macOS Installation - FmPro Migrator Batch Transfer

Open DMG File

=
Favorites Name @® @® L FmPro Migrator Batch Transfer
@) Airbrop (@ MAMP PRO.app 1 Qg
B Recents 85 Maps.app J
¢ Messages.app ‘ g
@3 Desktop £l Microsoft Excel.app ro Migrator Batch
M Documents @ Microsoft Remote Desktop.app ‘ Transfer.app
0 Downloads M?crosoft R?mote Des
a2 Micros ght ‘
m dsimpson icrosoft Word.app

¥ MindNode.app
Mission Control.app

2\ Applications

EEN B =

Open the FmProMigratorBatchTransferX.XXmacOS.dmg file, and drag the app to your Applications
folder. The FmPro Migrator Batch Transfer app is a 64-bit app, notarized by Apple to prevent error
messages when launching.

Note: The version number is notincluded in the name of the app, so thatit can be updated without
requiring a change to the job scheduler configuration.
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macOS - MySQL Client Installation for xferData.app

Skip this step if you don't need to transfer data from FileMaker to MySQL database servers. None
of the other servers require installing client library software on macOS

xferData.app - MySQL Client Software Dependency

?
PERL

xferData.app xferData.pl

The xferData.app is a 64-bit compiled perl executable, created with the perl2exe tool from
IndigoStar Software. In order to transfer data to MySQL database servers, the mysql client library
needs to be installed on macOS.
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Install HomeBrew

S
dap:
LF

Homebrew

The Missing Package Manager for macOS (or Linux)

A

English o

Install Homebrew

/bin/bash -c "$(Ccurl -fsSL https://raw.githubusercontent.com/Homebrew/install/master/install.sh)"

Paste that in a macOS Terminal or Linux shell prompt. The script explains what it will do and then pauses before
it does it. Read about other

The easiest way to install the MySQL clientlibrary is by installing HomeBrew.
[Note: The correct URL is http://brew.sh - not the similarly named homebrew.sh URL (which might
be a virus site).]

Use the URL shown on the website to start the installation via the macOS Terminal.app.

Unless you have already installed the Xcode command line utilities, these will automatically be
installed first.

Install mysql-client@5.7

Once HomeBrew is installed, use it to install the MySQL client software using the following
command:
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brew mysql-client@5.7

HomeBrew will install the MySQL client software along with any dependencies which are required.
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Configuration
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Configuration Options & GUI Explanation

Launching FmPro Migrator Batch Transfer - Windows

Name Date modified

Externals 4/9/20 8:04 PM

“ 4 FmPro Migrator Batch Transfer.exe 4/9/20 8:05 PM

| revpdfprinter.dIl 4/9/20 8:05 PM
revsecurity.dll 4/9/20 8:05 PM

To open the FmPro Migrator Batch Transfer utility, just open the extracted folder and double-click
on the FmPro Migrator Batch Transfer.EXE file.
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Launching FmPro Migrator Batch Transfer - macOS

Applications
< B = D& 2| v £ v Q
Favorites
@ AirDrop b]I% g
@ Recents
@3 Desktop FmPro Migrator Font Book.app Gemini 2.app gfxCardStatus.ap
Batch Tr...sfer.app p
0 Downloads //g
12} dsimpson .

A\ Applications

GoodNotes.app Google

GitHub
iCloud Desktop.app Chrome.app

& iCloud Drive \ P X
Locations h i @
D David's iPad Pro 12....
Macintosh SSD MBP16

[ MBP16 Backup 1

Google Earth GoogleEarthProM  GoToMeeting.app HandBrake.app
Pro.app ac-Intel.dmg

(1) Double-click the FmPro Migrator Batch Transfer icon in the Applications folder.
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Stopping the Automatic Countdown

oﬁ ) B &
< .com Solutions Inc.
FmPro Migrator Batch

+ - Transfer 1.03

This utility runs via a scheduled
job to transfer data from
FileMaker to SQL databases.

E 10

Batch Delay (sec.)

<Not Selected>

I

Select Project Folder

Add Table Q

Batch Transfer Tables: Delete Selected Table(s)

& O

Run Batch Quit

The FmPro Migrator Batch Transfer utility will automatically start counting down from 10 seconds
when itis launched. This is exactly the behavior you want if the app is running via an automated
schedule, but you want to stop this countdown when configuring the app.
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Clicking anywhere in the window will stop this automatic countdown.

If you don't click anywhere on the window of the app, FmPro Migrator Batch Transfer will attempt to
truncate data and transfer data for all of the tables in the list and then it will quit. If no tables have
been added, the app will just quit after the timer has counted down and no data transfer will be
attempted.

This screenshot shows that no tables have yet been added to the app for batch transfer.
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Setting Configuration Options

@ 59 o & 43

I
FmPro Migrator Batch
Transfer 1.03

This utility runs via a scheduled
job to transfer data from
FileMaker to SQL databases.

= 0 O

Batch Delay (sec.)

E <Not Selected> @

Select Project Folder

o,
Add Table ° @

Batch Transfer Tables: Delete Selected Table(s)

O 4 HO

Run Batch Quit

Each of the settings described here will be automatically saved into the preferences file when the

options is selected.
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(1) Batch Delay is set by selecting the number of seconds to delay from the pop-up menu
displayed whenever clicking the Batch Delay button.

Default = 10 seconds

(2) Click the Select Project Folder button to select the FmPro Migrator project folder. This is the
project folder used by FmPro Migrator to store the MigrationProcess.db3 project file.

(3) Add table. Click this button after selecting a table, then pressing the Shift Key while pressing
the Transfer Data button in the Migration Process window.

(4) Delete Selected Table button. Select the name of a table from the list, then click this button to
delete it from the list of batch transfer tables.

(5) List of batch transfer tables - empty by default.

(6) Click the Run Batch button, to immediately truncate tables and transfer the data again to all of
the table in the list.

(7) Click the Quit button or select the File -> Quit menu to quit the app.
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Select Project Folder

,n;n' o 8= §

e
, FmPro Migrator Batch
7~ Transfer 1.03

This utility runs via a scheduled
job to transfer data from
FileMaker to SQL databases.

w "

Batch Delay (sec.)

O B Assets_Management14_PHPO02_Project

Select Project Folder

Add Table °

Batch Transfer Tables: Delete Selected Table(s)

o O

Run Batch Quit

(1) Click the Select Project Folder button to select the FmPro Migrator project folder.
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Select Project Folder - Error Message

The selected folder doesn't contain the
MigrationProcess.db3 project file.

If the selected folder doesn't contain a MigrationProcess.db3 file, then itisn't an FmPro Migrator
project folder, and this error message will be displayed.

Suggestion:

(1) Double-check which folder is being used for the FmPro Migrator project folder.

(2) If FmPro Migrator has not yet been used, then create the SQL tables and start transferring data
for each of the tables manually first - to make sure that all database configuration options are
correctly set up first.

The FmPro Migrator Batch Transfer utility should be used after all database tables have been
created in the SQL database and transferred once manually.
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Add a Table - Step 1 - FmPro Migrator Transfer Data Button - Shift Key

Migration Process
CFs GUI

P . = E ] ]

A mwio ¢ |
Original Table New Table Source Destination Records |
Clients clients FileMaker 18 |MySQL

TOs

IELIESE  Relationships Value Lists Layouts  Scripts

Step 2:

Install the FileMaker Companies 2
ODBC driver. '
Members
laceholder table
Create an ODBC e

DSN matching the
DSN name listed in

the Table Details New Fieldname

window. company
company_address
Turn on ODBC city
Sharing within country
FileMaker. id
Menu: File > Sharing
> ODBC/JDBC
@ Step 4
Click the Get n -
FieldSize icon. ' 3

Troubleshooting:
Make sure the
specified ODBC DSN

Get Fieldsize Create Table

Completed

Transfer Data

Completed Completed

(1) Click on a table on the Migration Process window.
(2) Hold down the Shift Key
(3) Click the Step #4 -Transfer Data button.

FmPro Migrator will generate the xferData.pl script and write the xferData.EXE/App application and
will transfer the data to the SQL database using the xferData.pl script.
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Ignore Primary Key Error

If you have already transferred data into the SQL database, ignore this error dialog caused by
duplicate primary key values. You should have already tested performing the data transfer with

FmPro Migrator prior to reaching this step.

Note: All of the tables listed will be truncated first, before the data gets transferred. This is done in
order to prevent unique constraint errors with Primary Key columns.
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Add a Table - Step 2 - Add Table Button

® O FmPro Migrator Batch Transfer

.O'n' o &g

I 2
,. FmPro Migrator Batch
“ =" Transfer 1.03

This utility runs via a scheduled
job to transfer data from
FileMaker to SQL databases.

10

D(Q

Batch Delay (sec.)

Assets_Management14_PHP02_Project

]

Select Project Folder

Add Table °

Batch Transfer Tables: 1 Delete Selected Table(s)

companies [Users/dsimpson/fmpro_migrator/f

o O

Run Batch Quit

Click the Add Table button in the FmPro Migrator Batch Transfer utility.
In this example, the folder named "companies" will be created, the xferData.pl and the
xferData.EXE/Apps will be moved into the new folder, and the table with its path will be added to
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the Batch Transfer Tables list.

Missing xferData.pl Error

button in FmPro Migrator.

The missing xferData.pl error will be displayed if:

The xferDataPerl.pl file was not found.

Suggestion: Make sure to hold down the
Shift Key when clicking the Transfer Data

1) You didn't hold down the Shift Key while clicking the Transfer Data button.
2) If you click the Add Table button a 2nd time - after the xferData.pl file has been moved into the

folder named for the table being copied.

Repeat for Each Table

!

New Table
clients
companies
companies_2
members
nlaceholder table

Original Table
Clients

Companies
Companies 2

Members
nlaceholder tahle

FmwE ¢ =
. - Eees KB E)| 3

Source Destination |Fields |Records

FileMaker 18 [MySQL 342

FileMaker 18 |MySQL 5 3

FileMaker 18 MySQL 5 1

FileMaker 18 [MySQL 17 29

FileMaker 18 IMvSQI 1

Continue clicking on each of the tables in the list, then pressing the Transfer Data button while
holding the Shift Key - until you have added all of the tables to the list of batch transfer tables in the

FmPro Migrator Batch Transfer utility.
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Testing
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Testing the Batch Transfer
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Run Batch - Button

. ® C - - FmPro MigratorrBartch Transferr

B d
o 8= 9
.com Solutions Inc.
FmPro Migrator Batch

Transfer 1.03

This utility runs via a scheduled
job to transfer data from
FileMaker to SQL databases.

10

=

Batch Delay (sec.)

=

Select Project Folder

Assets_Management14_PHP02_Project

companies
G |
Add Table 1 3 °
Batch Transfer Tables: 3 Delete Selected Table(s)
companies [Users/dsimpson/fmpro_migrator/f
members /Users/dsimpson/fmpro_migrator/fr
tbl_assets /Users/dsimpson/fmpro_migrator/fr

o O

Run Batch Quit

Once you have added all of the tables to the batch transfer list, click the Run Batch button.

The FmPro Migrator Batch Transfer utility will truncate the tables in the SQL database then it will
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start executing the xferData.EXE/xferData.app applications within each of the individual folders to

transfer the data.

Testing Results

( NON

s B
©
Connection New Query
Gcloud - MySQL
MAMP_test
v L\ mysql5_MBP15r2
§ information_schema

§ mysql

-
& performance_sche...

§ sys
§ Tasks
£ test
v £ test2
v @ Tables
@ companies
@ companies_2

@ container_te...

@ container_te...

@ members
A mamhare o

-aD-
O

Navicat Premium

e B fw & S

Z O

Table View Function Others User Query Backup  Automation
Objects ff] companies@test2 (mysq... ] members@test2 (m: »
B. Y I R 8
company company_address city country id
ABC Company 345 Industrial Park Blvd. Chicago USA
DEF Ltd. 789 Ring Road London UK
XYZ Inc. 67 Queen’s Rd Ontario  Canada
+ - (] = « 1 » 3 & [

3 records in page 1

N

Model Charts

® B

. companies
Table

Rows

Data Length
156 bytes (156)

Engine
MyISAM

Created Date
2020-04-09 20:08:09

Modified Date

ANAN AA AA ANAOAN

Then you can use your favorite SQL database management tools to view the data which has been
transferred. To verify that updated data has been transferred from the FileMaker database, make
changes to a specific table, run the batch transfer and verify that the new data is displayed in the

SQL database tables.

Or you could manually modify records in the SQL database, run the batch transfer, and then verify
that the changes were overwritten.
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Troubleshooting
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Troubleshooting

ErrorLog.txt File

‘& ErrorLog.txt

vilgrationrrererences.dd

& MigrationProcess.db3

FmPro Migrator Batch Transfer Error Log Thursday, April
9, 2020 7:01:58 PM

companies DBI
connect('example_fmp_dsnl7','Admin',...) failed: [iODBC]
[Driver Manager]Specified driver could not be loaded
(SQL-IM0@3) [state was IMOO3 now 00000]

[i0DBC] [Driver Manager]ldlopen(/Library/0DBC/FileMaker
0DBC.bundle/Contents/Mac0S/fmodbc.so, 6): no suitable
image found. Did find:

/Library/0DBC/FileMaker ODBC.bundle/Contents/
Mac0S/fmodbc.so: no matching architecture in universal
wrapper

/Library/0DBC (SQL-00000) at (eval 63) line 104

members DBI connect('example_fmp_dsnl7','Admin’',...)
failed: [iODBC] [Driver Manager]Specified driver could not
be loaded (SQL-IM@@3) [state was IMO@3 now 00000]
[i0DBC] [Driver Manager]ldlopen(/Library/0DBC/FileMaker
ODBC.bundle/Contents/Mac0S/fmodbc.so, 6): no suitable
image found. Did find:

/Library/0DBC/FileMaker ODBC.bundle/Contents/

Mo aNC /L dle v e m o B e e e S B e e e, |

ErrorLog.txt

text - 2 KB

Information

Created Thursday, April 9, 2020 at 7:01 PM
Modified Thursday, April 9, 2020 at 7:01 PM
Last opened Thursday, April 9, 2020 at 7:05 PM

If errors occur during the batch processing, these errors will be written into the ErrorLog.txt file.This
file will be written into the FmPro Migrator project folder selected for batch processing. This file
gets overwritten each time batch processing runs, so it won't grow in size.

Suggestion:

If errors occur, go back to FmPro Migrator and test transferring data again, either with the Shift Key
held down or without holding the Shift Key down.
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Upgrading from 1.03 to 1.04 Versions

FmPro Migrator Batch Transfer 1.04 (or higher versions) is dependent upon using FmPro Migrator
Platinum Edition 9.00 or higher. The reason for this dependency is due to changes which have
been made within the xferData.EXE/xferData.APP executables.

On Windows:

1) These executables are now available in 32-bit and 64-bit versions.

2) The DBD::mysqgl and DBD::Pg modules are now being used, which require Strawberry Perl and
the DBD database driver modules to be installed on the local machine. The xferData.pl scriptis
run directly by FmPro Migrator and FmPro Migrator Batch Transfer

On macOS:

1) The name of the executable inside the file bundle is now named xferData instead of the
previous longer name.

2) The xferData.app is run by executing the executable inside the bundle instead of just launching
the bundle itself.

3) The xferData.app is now a 64-bit executable, when previously it was a 32-bit executable.

Switching Database Server Types

Generally, most customers won't run into this issue, but it has been observed during testing.

If you switch from using one database server type (i.e. MySQL), to another server type (i.e.
PostgreSQL), then you need to re-select the project folder again. This is because the destination
server type and connection info is read into preferences only once and then itis stored. This info is
used in two places:

1) The destination server type is used for constructing the syntax of the TRUNCATE TABLE
command. SQLite uses DELETE instead of TRUNCATE but that is the only syntax change which is
made internally within the software.

2) The database connection info is used to send the TRUNCATE TABLE command. Without the
proper database login info you could run the TRUNCATE TABLE command against the wrong
database.

If you change your database server login credentials, you would also need to update this info
within FmPro Migrator Platinum Edition, the changes would get written into the
MigrationProcess.db3 file within the project folder. Then you would select this folder again so that
the prefs could be read and used by FmPro Migrator Batch Transfer.

3) Also, if you changed your database server login credentials, you would need to update the
xferData.pl perl scripts used for each database table.

Note: Though it might look possible when looking at the GUI, FmPro Migrator Batch Transfer is not
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designed to transfer data to different servers at the same time. Mainly, this is due to there being
only one central location where the database connection info is stored for the TRUNCATE TABLE
command.
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DBD::Pg - load_file:The specified module could not be found - Windows

DBD::Pg Error Dialog

. e , -

Ea An error occurred while running the Transfer Data step.

Error:
Can't load "C:\Users\ADMINI~1\AppData\Local\Temp\p2xtmp-4008/auto/D8D/Pg/Pg.xs.dlI' for module DBD::Pg: load_file:The specified module could not be found

{ Make sure there are no spaces. hyphens or special characters in the table name. Change the table name and re-import into Fméro Migeator.  § Suggestion B

This dialog is displayed in FmPro Migrator if the DBD::Pg module has not been installed prior to
running the xferData.exe executable.
Click any button to continue.

The full text of the error message is located within the xfer_failed.txt file in the same folder where
the xferData.exe executable is found.
The error text will look similar to the following:

Can't load 'C:\Users\ADMINI~1\AppData\Local\Temp\p2xtmp-1772/auto/DBD/Pg/Pg.xs.dIl' for
module DBD::Pg: load_file:The specified module could not be found at
PERL2EXE_STORAGE/DynaLoader.pm line 193.

at (eval 9) line 42.
Compilation failed in require at (eval 9) line 42.
BEGIN failed--compilation aborted at (eval 9) line 42.

Before using the xferData.exe executable to transfer data on Windows, the DBD::Pg module needs
to be installed. For more details, see the installation instructions for Windows.

This error will only occur if data is being transferred to a PostgreSQL database server.
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DBD::mysql - load_file:The specified module could not be found - Windows

DBD::mysql Error Dialog

An error occurred while running the Transfer Data step.

Error:
install_driver(mysql) failed: Can't load ‘C:\Users\ADMINI~1\AppData\Local\Temp\p2xtmp-2336/auto/DBD/mysql/mysqlxsdil’ for module DBDzmysqi: load_file:The specified moduk

Make sure there are no ces. hyphens or special characters in the table name. Change the table name and re-import into FmPro Migrator. | Suggestion at (eval 9) line 116,
spac spe L 3z -l 99

The full text of the error message is located within the xfer_failed.txt file in the same folder where
the xferData.exe executable is found.
The error text will look similar to the following:

install_driver(mysq]l) failed: Can't load
'C:\Users\ADMINI~1\AppData\Local\Temp\p2xtmp-5100/auto/DBD/mysql/mysql.xs.dll' for
module DBD::mysql: load_file:The specified module could not be found at
PERL2EXE_STORAGE/DynalLoader.pm line 193.

at (eval 11) line 3.
Compilation failed in require at (eval 11) line 3.
Perhaps a required shared library or dll isn't installed where expected

at (eval 9) line 116.

This dialog is displayed in FmPro Migrator if the DBD::mysql module has not been installed prior to
running the xferData.exe executable.

Click any button to continue.

Before using the xferData.exe executable to transfer data on Windows, the DBD::mysql module
needs to be installed. For more details, see the installation instructions for Windows.

This error will only occur if data is being transferred to a MySQL database server.
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Configuring a Windows
Scheduled Job
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Using the Windows Task Scheduler
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Open Task Scheduler - Windows 7

Programs (1)

() Task Scheduler @

Control Panel (19)

ol Taskbar and Start Menu

[ Perform recommended maintenance tasks automatically
1% View running processes with Task Manager

ol Auto-hide the taskbar

ol Customize the taskbar

ol Group similar windows on the taskbar

,_I_ Lock or unlock the taskbar

. Turn toolbars on the taskbar on or off

Customize icons on the taskbar

Show or hide inactive icons on the taskbar

= Show or hide the notification area on the taskbar
Show or hide volume (speaker) icon on the taskbar

Show or hide battery icon on the taskbar

f0 D ED ED ED fD

Show or hide clock icon on the taskbar
Schedule tasks
:.E View network status and tasks
k. What happened to the Quick Launch toolbar?
Remove icons from notification area (system tray) on the deskt...

[ View list of running gadgets

- See more results

—
| task ‘1’ x| | Shutdown | » |

(1) Click the Start menu, then start typing the application name into the search box.
Before you finish typing the entire word, Windows will show the Task Scheduler in the list of apps.
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(2) Click Task Scheduler in the listto open it.

Open Task Scheduler - Windows 10

All Apps Documents Settings Web More ¥ oy
Best match
Task Scheduler ¥
$ ] s _+__
App ¥ . ./
Apps
Task Scheduler
»~' Task Manager > App
Settings
Tasks privacy settings > =7 Open
Search the web CO  Run as administrator
/O task s - See web results > Il Open file location
<2 Ppin to Start
<= Ppin to taskbar

Click the Start menu, then start typing the text: task scheduler
Before you finish typing the entire word, Windows will show the Task Scheduler in the list of apps.

Click Task Scheduler in the list to open it.
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Create Basic Task...

Task Scheduler

File = Action View Help
e Create Basic Task...

Ta Create Task...

0—@ Import Task...

Display All Running Tasks
Enable All Tasks History

o —

pda.. Ready Multiple triggers defined
pda.. Ready At12:12 PM every day - After triggered, repeat every 1 hour for a duratig

Status Triggers

St.. Ready At 11:00 AM on 5/1/92 - After triggered, repeat every 1.00:00:00 indefinit
New Folder... M... Ready At9:21PM on 12/7/19
d_S.. Ready At12:47PM every day - Trigger expires at 2/14/30 12:47:33 PM.
Refresh
Help >
General Triggers Actions Conditions Settings History (disabled)

Name: GoogleUpdateTaskMachineCore ~

Location:  \

Author:

Description: | Keeps your Google software up to date. If this task is disabled or stopped, your
will not be kept up to date, meaning security vulnerabilities that may arise canr
features may not work. This task uninstalls itself when there is no Google softwi

Security options
When running the task, use the following user account: v
< >

Quickly creates a simple task.

(1) Click the Task Scheduler Library folder.
(2) Select the Action -> Create Basic Task... menu item.

VIILR vapLluic

T TT———

Actions

g

®

i
©

4

$

L

X

R R —

Create Basic Task...

Create Task...

Import Task...

Display All Running Tas...
Enable All Tasks History
New Folder...

View >
Refresh

Help

Selected Item -

Run

End
Disable
Export...
Properties
Delete
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Name the Task

Create Basic Task Wizard X
L )
@| Create a Basic Task

Create a Basic Task Use this wizard to quickly schedule a common task. For more advanced options or settings

such as multiple task actions or triggers, use the Create Task command in the Actions pane.

Trigger
Action Name: FmPro Migrator Batch Transfer Launcher
Finish Description: Launch the FmPro Migrator Batch Transfer app to transfer data from FileMaker

to SQL databases)

®

< Back ( : E Next > Cancel

(1) Enter a name for the scheduled task.
(2) Enter a description for the scheduled task.
(3) Click the Next button.
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Configure Trigger

Create Basic Task Wizard

—
"®| TaskTrigger

) VRS

Create a Basic Task

When do you want the task to start?

®osy ()

Action
Finish

(O Weekly

O Monthly

(O Onetime

(O When the computer starts

(O Whenllog on

(O When a specific event is logged

< Back ‘:ENext> |

Cancel

(1) Click the radio button for a Daily task.

(2) Click the Next button.
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Choose Time

Create Basic Task Wizard X
Qp—
®| Daily

Create a Basic Task

Start: | 4/13/20 [E~ || 3:05:00 AM 1 : ? [CJiSynchronize across time zones:
Trigger
Recur every:

Action
Finish

—

days

< Back < :! Next > Cancel

(1) Select the time of day when the task should run.
(2) Click the Next button.
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Select Action - Start a Program

Create Basic Task Wizard
L —

@| Action
]

Create a Basic Task
What action do you want the task to perform?

Trigger
Weekly
@ startaprogram Q)

Finish (O Send an e-mail (deprecated)

O Display a message (deprecated)

< Back ‘:E Next >

’ Cancel

N

(1) Click the Start a Program option.
(2) Click the Next button.
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Select Application to Start - (1)

| Create Basic Task Wizard

\

|

@®| Start a Program
 —

Create a Basic Task

Trigger Program/script:

N/
PaN

Weekly

Browse... o |

Action

Add arguments optional

Finish Start in (optional):

< Back

Next > Cancel ||

(1) Click Browse button.
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Select Application to Start - (2)

Bz -

Date modified

4/9/20 8:04 PM

4/9/20 8:05 PM
4/9/20 8:05 PM

X

Search FmPro Migrator Batch ... ©

m @

Type
File f
Appl
Appl
Appl

Open
— " <« Fmig... > FmPro Migrato... » v O
Organize v New folder
WinAutomation Name B
@ OneDrive Externals
—— “ » FmPro Migrator Batch Transfer.exe @ 4/9/20 8:05 PM
= ThisPC revpdfprinter.dil
- 3D Objects revsecurity.dll
B Desktop
Documents
<& Downloads
D Music
&= Pictures
B Videos
‘s LoOcal Disk (C:)
I SR N P v £
File name: | FmPro Migrator Batch Transfer.exe v

(1) Navigate to the location where the FmPro Migrator Batch Transfer app was installed, select its

EXE file.
(2) Click the Open button.

All files (*.*)

Open @

Cancel
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Select Application to Start - (3)

Create Basic Task Wizard
s
"@®| startaProgram

Create a Basic Task

Trigger Program/script:
Daily "C:\ds\Fmig_Batch_Data_Transfer\FmPro Migrator Batch Transfer 1.03\| Browse...
Action
Add arguments (optional)
Finish Start in (optional):

< Back @ Next > Cancel

(1) Click the Next button.
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Click Finish Button

Create Basic Task Wizard

“;-P
Summary

Create a Basic Task
FmPro Migrator Batch Transfer Launcher

Trigger Name:
Daily Description: | Launch the FmPro Migrator Batch Transfer app to transfer data from
Action FileMaker to SQL databases.

Start a Program

Trigger: Daily; At 3:05 AM every day

Action: Start a program; "C:\ds\Fmig_Batch_Data_Transfer\FmPro Migrator Batch Tra

@ [“] Open the Properties dialog for this task when | click Finish
When you click Finish, the new task will be created and added to your Windows schedule.

< Back @ Finish Cancel

(1) Click the checkbox next to the Open Properties dialog (2) Click the Finish button.
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Scheduled Job Properties - Run Whether User is Logged On or Not

(® FmPro Migrator Batch Transfer Launcher Properties (Local Computer)

General Triggers Actions Conditions Settings History (disabled)

Name: FmPro Migrator Batch Transfer Launcher
Location:  \
Author: DAVIDSIMPSOAS89\dsimpson

Description: | Launch the FmPro Migrator Batch Transfer app to transfer data from FileMaker to SQL
databases.

Security options
When running the task, use the following user account:
DAVIDSIMPSOAS89\dsimpson Change User or Group...

O Run only when user is logged on

@ Run whether user is logged on or not

[] Do not store password. The task will only have access to local computer resources.

[[] Run with highest privileges

[] Hidden Configure for: | Windows Vista™, Windows Server™ 2008 v|

( : ! OK | Cancel

Because you checked the "Open Properties" checkbox on the previous window, the scheduled job
properties you just created will be opened. (1) Click on the radio button "Run whether user is
logged on or not", (2) Click the Ok button.
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Configuring a macOS
Scheduled Event
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Using the Scheduler App From: www.macscheduler.net

Downloading Scheduler for Macintosh

Scheduler for Macintosh

Version 7

What's New Downloads Register Contacts

A free all-around scheduling utility for the Mac

Downloads

Scheduler Version 7.3

Current

Legacy -

Date: 16 December 2019

Requires macOS Sierra (10.12) or later

3]

The Scheduler app is available from: hitps://www.macscheduler.net/download.html

This app is available for free, but does require submitting an email for registration to receive a free
license key via email.
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Install Scheduler App

A
F

Applications Scheduler.app

.“

Uninstaller.app

Double-click on the Scheduler.dmg file to open the disk image. Drag the Scheduler.app icon to the
Applications folder you see within the DMG window.

Launch Scheduler.app

! N WA WA IIUPF

5/ ScanSnap Home.app
» | | ScanSnap Online Update
o % Scheduler.app
& Scheduler7.dmg
O Screenium 3.app
K& Screenshot Toolbar 1.01.app

(1) Launch the Scheduler.app by double-clicking its icon within the applications folder.
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Create Scheduled Event

Window
S @ @ E @
9 €0 @@ *+)
Group Alert §Application ocument Script Delete Clone Go Stop Sounds Hotkeys Calendars
Due ~  Deferred Calendar

Bl= o

il

Click the Application icon in the Scheduler configuration window.
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Scheduled Application Event Window

® Run FmPro Migrator Batch Transfer

O

Title: ‘ Run FmPro Migrator Batch Transferl ‘

Date and time of launch:

Date Time

G /132020 || 3:05AM :©®

Monday

\ 4
Application or applet to launch:

FmPro Migrator Batch Transfer.app @ Browse...

Launch options:

Launch on computer startup

| Launch after minutes of inactivity: 15 4 minutes

@ © Launch on date and time
¥V Options:

@ Repeat: Every day

Snooze for: c

Activate between: ~ and v

Cancel ©® OK

(1) Enter a title for the scheduled event, (2) choose a date and (3) time for the first time the FmPro
Migrator Batch Transfer app should run, (4) Browse to select the FmPro Migrator Batch Transfer

app, (5) select the Launch on date and time radio button. (6) Click the Repeat checkbox then
select your desired repeatinterval.

If more flexibility is needed for scheduling, then the Custom... menu option can be selected, which
will open another configuration window with more details.

FmPro Migrator Batch Transfer - Usage Manual - 65



When setting a time of day for running the Printer Maintainer, you may want to configure the app to
run when users won't generally be using the computer. The computer needs to be turned on, but if
a user is performing other tasks they could be surprised to see the app open on its own. FmPro
Migrator Batch Transfer will quit when it has completed printing. But if the user clicks anywhere on
the FmPro Migrator Batch Transfer window, it will pause the countdown timer indefinitely.

(7) Click the Ok button to save the changes.

Application Event in List

| NON ) Window
% ) 6 /N %] ﬂ
s Y ) 38
j L g O @ @ @ y U4

Group Alert Application Document Script Delete Clone Go Stop Sounds Hotkeys Calendars
Active Name Due v Deferred Calendar

/A Run FmPro Migrator Batch Transfer today, 30M None @
B:=:= o

(1) click the Deferred checkbox so that itis unchecked, (2) select None from the Calendar menu.
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Registering the Scheduler App

0

Search

Scheduler Help

What's New

Scheduler's Web Site

Is this the latest version?
End User License Agreement

Select (2) Register Scheduler from the (1) Help menu to register the app for free on the computer
where itis being used.
The website will open with a registration form.
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Registration Form

A free all-around scheduling utility for the Mac

Registration

Register Scheduler Registration form
to ensure that
public versions of
the software will be - Although Scheduler for Macintosh is freeware, registration is

. mandatory after a 30-day trial period. Fill in this registration form and
available to you for submit it to receive an email message containing a free registration
free and to let us code. This registration allows us to measure our installed base and
know that there is verify whether new public releases of the software are worthwhile.
interest in it.

Version you wish to register: o
Name: — 9‘
Email: = 9
Email: ‘e‘

6 | | want to be warned when a new release of the software comes out.

(CsuBMiT = @

(1) Select the version you want to register, (2, 3, 4) enter your name/email info, (5) select the
notification checkbox if you want to be notified of updates, (6) click the Submit button.
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